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Who should read this release note?
This Centricity Practice Solution (CPS) 2006 Service Pack 5 (SP5) 
release note describes the changes included in the service pack 
and the installation process.

Before installing the service pack, read this release note carefully 
and ensure that you have a verified backup.

If you are the System Administrator...
Review system and pre-install requirements and   installation 
instructions carefully and confirm that you have a verified 
complete backup. 

You will need the following:

 Supervisor/admin privileges on your network file server

 Ability to set up and configure system security policies

 Ability to execute SQL queries

 Familiarity with SQL Server 2005 files, programs, data 
structures, and transaction architecture

If you are the CPS Manager...
Carefully review and consider how the changes in this service 
pack affect your practice setup and workflows. If you have 
questions about how these changes will affect your practice, 
contact Centricity Practice Services at 888.436.8491 option 2.

What’s new in this service pack?
Service Pack 5 includes fundamental changes to the application 
architecture which reduce time-sensitive system lock-ups and 
exceptions and create a more stable application. Specific 
changes included in this service pack are summarized below:

Closing windows or switching windows
A coding change throughout the application significantly 
reduces error messages when you close application modules or 
switch to a different window. SPR#25486, 30958, 30863, 31098, 
28436, 31109, 10042

Idle timeout
In Service Pack 5, the application hides all open practice 
management windows on an idle timeout or user log out. Users 
are able to return to their work within the application after they 
log back on. In previous versions, windows with unsaved 
changes would not close until the user saved the changes.
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 If a user logs out or times out of the application before saving his or her 
changes and another user logs in, all changes from the previous user are 
lost.

SPR# 29134, 23844, 30213, 30861, 30865, 28934, 30859, 29459, 30996, 31248

Registration keyboard shortcuts
In the Registration module Columns window, users can use the ALT + R 
keyboard shortcut to remove a selected column from the list of displayed 
columns. If the column is a permanent column, a warning dialog appears to 
notify users that the column cannot be hidden. You can access the Columns 
window from the Registration module Insurance, Appointments, and 
Contacts tabs. SPR# 29312

Transaction Distribution and remittance processing
A change to the application ensures the continuity of workflow for remittance 
processing and other tasks within Transaction Distribution. In previous 
versions, users working in Transaction Distribution may occasionally 
experience errors when toggling between Transaction Distribution and other 
modules, posting a remittance check, or reordering a transaction column set 
that contains the Residual field. SPR# 29784, 31705, 30678, 30958, 30853, 
30962

Daily appointment schedule
In Service Pack 5 users can drag and drop appointments to any available slot.

In previous versions of the application, users employing the drag-and-drop 
method of appointment scheduling on the Daily view may encounter 
overbooked appointments where the schedule displays an available 
appointment slot. SPR# 29978

Skinning support
A coding change in this service pack eliminates window ‘flickering’ in the 
Administration module and does not lock up the system. Previously, some 
users may have experienced window flickering when searching for items in 
Administration, for example appointment types and allocation sets. SPR# 
29317

In addition, a coding change allows users to use the side scroll bar to scroll 
through a list of items in a ‘Find’ window. Previously, users were unable to use 
the scroll bars. SPR# 30898

Accounts Receivable
A coding change in this service pack ensures that users are able to modify In 
Progress visits from within the Accounts Receivable module. In previous 
versions, users may be unable to modify a visit from within Accounts 
Receivable. SPR# 30843
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Support for single CPU configuration
To assist in debugging the application, this enhancement allows the client 
application to be configured to use a single CPU on hyper-threaded and multi-
core workstations. To configure the application for a single CPU: SPR# 30855

1 Go to the client install folder (for example, C:\Program Files\Centricity 
Practice Solution 2006\Client)

2 In the emr.ini file, in the [Logician Private] section, set 
UseMultipleCPU=0.

3 Save the file.

4 Start the CPS client and log into the application.

5 Open the Windows Task Manager.

6 From the Processes tab, search for and right-click the CPOPM06.exe 
process.

7 Select Set Affinity.

In the Processor Affinity window, verify that one CPU is checked.

Windows® Vista support
Beginning with Service Pack 4, Centricity Practice Solution is compatible with 
Vista. 

 Read this section if you are not upgrading from Centricity Practice Solution 
Service Pack 4.

Support for Windows® Vista
Windows Vista Business Edition operating system is compatible with this 
service pack. Your workstation must meet the following system requirements 
in order to use Vista and Centricity Practice Solution on your workstation:

 Processor: Pentium4, 2 GHz or higher

 RAM: 4 GB

 Virtual memory/page file space: 1.5X physical RAM

 Disk space: 36 GB or larger hard disk

 Network: 100 Mbit (100Base-T) or higher network card. Gigabit (1000Base-
T) preferred

 Network protocol: TCP/IP only

 Internet connection: High-speed connection recommended

 Modem: DSL/cable or other high-speed fax/modem
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 Vista Business Edition is the only compatible version of Microsoft Windows 
Vista for Centricity Practice Solution Service Pack 5.

Centricity Practice Solution is not supported on tablet PCs using the Vista 
operating system.

Before upgrading, verify that your current third-party applications and 
peripherals (such as scanners, cameras, and other hardware) are 
compatible with Vista.

Internet Explorer 7
Internet Explorer 7 is compatible with Service Pack 5.

Protected Mode is a new security feature of Internet Explorer 7 for Vista that 
prevents the installation of malicious software on users’ computers through 
the Web sites users may visit . Protected mode is turned on by default in the 
Internet, intranet, and restricted sites zones, and an icon appears on the 
status bar to let you know that it is running. Protected mode may prevent 
some EDI plug-ins from processing approvals correctly. If you are using

 Internet Explorer 7 with Vista, you must clear the Protected Mode checkbox 
before proceeding with the approval process:

1 In Internet Explorer, click on Tools > Internet Options.

2 Select the Security tab.

3 Clear the Enable Protected Mode (requires restarting Internet Explorer) 
option.

A Warning message displays to confirm your selection.

4 Click OK.

5 Click OK to close the Internet Options window.

Microsoft Word 2007
The Rich Text Format (RTF) of Word 2007 is larger, and significantly increases 
document file sizes. It also includes new tags that are not compatible with 
Centricity Practice Solution.

To prevent errors, GE removed the option for saving formatted text in the 
NotesLink Macro when importing transcriptions created in Word 2007. If you 
attempt to paste Word 2007 text into a Chart text field that includes RTF 
controls (such as chart notes, history views, text components, letter handouts, 
or document templates), you will be directed to copy the text to Wordpad first 
before pasting to the text field. You can use any text editor that does not 
contain Word 2007 RTF tags.

Integrated faxing in Vista
The application supports Biscom version 9.0.4.0100 for integrated prescription 
faxing. To use integrated faxing, you must install a Biscom Faxcom server on 



GE Healthcare Centricity Practice Solution SP5 Release Notes

Revision D October 2009 5
© 2009 General Electric Company - All rights reserved

your network and the Biscom fax client on your workstations. Installation 
instructions are included in the Biscom documentation.

Adding printers in Vista
When adding a printer in Vista, install the drivers by selecting a printer in 
Control Panel > Hardware and Sound > Printer and entering a valid directory 
or network path to the printer and drivers as needed.

Before you begin....
Before installing this service pack, please review the following checklist of 
system requirements, important pre-installation considerations, and steps to 
watch out for during the install to ensure a successful upgrade.

 Citrix Presentation Server 4.0 was fully tested with Centricity Practice 
Solution 2006. GE is not aware of any incompatibility issues with Citrix 
Presentation Server 4.5 Rollup 02.

 Confirm upgrade paths
Review the upgrade matrix below to determine whether or not you should 
upgrade to this service pack, and which other releases are available for you:

(1) 8.0.5 has some changes not included in 8.1.0, 9.0.0, or 9.0.1
(2) 8.1.0 has some changes not included in 8.0.5 and 9.0.0

 Confirm system hardware and software requirements
Review all hardware and software requirements for your system and confirm 
that your system meets minimum requirements. See “Appendix A: Hardware/
software requirements for Centricity Practice Solution” on page 42.

Critical hardware checks:

 Follow GE recommendations for database server RAM, disk arrays, and 
disk and database file layout. See “Database server” on page 42.

Target Version

8.0.4 8.0.5 8.1.0 9.0.0 9.0.1 9.0.2

8.0.4 Possible Possible Possible Possible Possible

8.0.5 Avoid (1) Avoid (1) Avoid (1) Recommend

8.1.0 Avoid (2) Possible Recommend

9.0.0 Possible Recommend

9.0.1 Recommend

9.0.2

C
ur

re
nt

 V
er

si
on
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Critical software checks:

 Windows Server 2000 not supported. Windows 2000 Server is no longer 
supported for your database server operating system because it does not 
facilitate memory management requirements needed for Centricity 
Practice Solution on SQL Server 2005. For details, see “Microsoft Windows 
2000 Server and Small Business Server 2000 are no longer supported.” on 
page 44.

 Set required system settings for performance/uptime
Before running the application the first time after install or update, you must 
set or confirm settings for several critical configurations on the database 
server to optimize Centricity Practice Solution performance and up time on 
Microsoft SQL Server 2005. Configurations include

 Adding the -g startup flag

 Using AWE to allocate memory and setting Max Server Memory to 1 GB 
less than total system memory 

 Enabling Lock Pages in Memory OS security setting.

 Editing the boot.ini file to enable PAE. 

For detailed instructions, see “Configure SQL Server 2005 for performance / 
uptime” on page 13.

  Configure SQL Server to run the client on the server 
If you are running the client on the database server, you must also select 
(local) named pipes and TCP/IP protocol for remote connection when setting 
up SQL Server, otherwise you may see a named pipes error when you launch 
the application. See “Configure SQL Server 2005 to run the client on the 
server” on page 16. 

  Upgrading from Centricity PM: configure Application Logon

If you installed SQL Server 2005 as a separate instance and plan to 
restore a backup of PM 2004 to this instance before upgrading to 
Centricity Practice Solution Service Pack 5, you must configure your 
PM Application Logon for SQL Server 2005. See “Single-user Demo 
Database cannot be upgraded” on page 19. This step is required to 
give SQL Server 2005 access to the current PM database for the 
upgrade and prevent client security issues on the client. #1

 Review Active Directory changes for system impacts
Take these steps before installing the service pack:

 Check for invalid characters in Active Directory names. To avoid 
authentication problems after upgrade/install, check for and modify 
invalid/unsupported characters in names in Active Directory 
containers, groups, and users. See “Invalid/unsupported characters 
for Active Directory” on page 12.
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 Check for Active Directory Group Name mismatches. To ensure that 
you can access all security groups after upgrade/install, check in 
Active Directory for groups where Group Name and Pre-Windows 
2000 Group Name are different.

 If you find groups with unmatched names, you must take some extra 
steps during the installation process to update group names 
automatically. See “Update Active Directory Group Names” on 
page 28. 

!!! If you do not take these steps, you will need to reassign security 
permissions to these groups after the update.

 JOBS.TXT users ONLY

 You must back up your JOBS.TXT file and the Source folder in your website 
before installing the service pack.

If you are using Windows 2003 on your server, you must verify that a MIME 
type exists before users log into the client after installing this update. This 
process is also described at http://support.microsoft.com/kb/326965. 

 Configuring a MIME Type

Use the following steps to configure a MIME type.

a Open the IIS Manager: Start > Control Panel > Administrative Tools > 
Internet Information Services (IIS) Manager.

b Expand the local computer name in the left panel.

c Expand Web Sites, then Default Web Sites, and expand your website’s 
folder. 

d Right-click the Source folder and then click Properties. The Source 
Properties window opens.

e On the HTTP Headers tab, Click MIME Types. 

f Click New. The MIME Type window displays.

g In the Extension field, enter *.

h In the MIME Type field, type application/octet-stream.

i Click OK twice to close the MIME Types window.

j Click Apply, then OK on the Source Properties window to confirm the 
changes. 

k You must restart the World Wide Web Publishing Service or wait for 
the worker process to recycle for the changes to take effect. In some 
cases, you may need to reboot the server.

http://support.microsoft.com/kb/326965
http://support.microsoft.com/kb/326965
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 If you do not immediately see the new MIME type and do not want to 
shut down the server, use the iisrest.exe command-line utility to force 
a restart of the services alone. At a command line, type iisreset /
help for more information.

 Removing application-specific files for previous service packs 

Edit the JOBS.TXT file to remove all jobs (lines) that push application-
specific files from a previous version of the product, such as

 MLDEF.TXT files, for example, MLDEF1.TXT, ML2DEF.TXT, 
ML3DEF.TXT, and so on

 Client-side .DLL files, for example, MLINFORM.DLL

DO NOT remove custom lines that push 3rd-party files and custom 
clinical content and forms, including CCC forms. 

!!! JOBS.TXT runs whenever users log into the application on the 
workstation. If you do not remove client-specific lines from 
JOBS.TXT, older files may be pushed to the new client that render it 
inoperable. 

On Vista workstations, you must log in to the client by running 
Internet Explorer as an administrator before the JOBS.TXT runs. 
See “Install the service pack to workstations” on page 26 for 
instructions for running Internet Explorer as an administrator.

 During install/update take these critical installation steps

 Correct SQL instance names. If your SQL Instance name includes a 
machine name such as “VSH-MIS06\SQL2005”, you must manually correct 
it wherever it displays in Server Setup during installation process. “SQL 
Instance name with a forward slash is truncated in Server Setup” on 
page 40.

 Restart SQL Server following database installation to ensure that 
MBCXP80.DLL is updated and loaded. In the database installation 
procedure, see step 23 on page 23.

 Prevent OCX errors on workstations on first launch. To avoid OCX 
registration errors on some workstations, either log onto the workstation 
with Administrator rights to launch the application for the first time or 
grant all users Administrator rights for the first day following installation. 
See “OCX registration errors may occur on some workstations 
immediately after installing the service pack” on page 40.
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Before you install Service Pack 5...

Upgrading from EMR or early version of CPS 2006?

Save your EMR.ini custom settings 
EMR.ini is overwritten when you apply the service pack to workstations. If you 
have integrated any third party applications (e.g. Biscom Faxing) back up or 
save a copy of the current EMR.ini file before applying the update. Then 
manually restore any custom settings to the file after the update. Make sure 
this file is updated on all affected workstations.

Complete all service orders before upgrading
Before applying this service pack, please confirm that all service orders 
created in the EMR application/Chart module have the status Completed. 
Orders In Process or Admin Hold states prior to the upgrade may generate 
new, separate visits after the upgrade occurs. PR17911

You can run an inquiry in Chart to find uncompleted orders. To have your IT 
staff find this data using a SQL query instead, see“Find incomplete orders with 
a SQL query” on page 9. 

Find incomplete orders with a Chart inquiry

1 Go to Chart > Desktop > Reports and select the Inquiries tab.

2 Run an inquiry using the following criteria:

Find Orders
Where Status
is
In Process

3 Click Add and combine with OR

Find Orders
Where Status
is
Admin Hold

 To list only Services orders, add Find orders where Type is Service. 
This filters for orders typically set to transfer to the Billing component.

4 View or print the Inquiry results and complete outstanding orders.

5 As you complete orders, re-run the inquiry to refresh the list of outstanding 
orders. 

Find incomplete orders with a SQL query
Run the following SQL script and use the output (DTS to Excel for formatting) 
for your working list:

SELECT "vPatientProfile"."firstname", "vPatientProfile"."middlename", 
"vPatientProfile"."lastname", "ORDERS"."STATUS", "ORDERS"."ORDERTYPE", 
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"ORDERS"."ORDERDATE", "ORDERS"."CODE", "ORDERS"."DESCRIPTION", 
"ORDER_ENTRY_MODIFIERS"."CODE" AS "MODIFIERCODE", 
"ORDER_ENTRY_MODIFIERS"."DESCRIPTION" AS "MODIFIERDESCRIPTION"

FROM {oj (((“dbo”.”ORDERS” “ORDERS” INNER JOIN “dbo”.”USRINFO” 
“USRINFO” ON “ORDERS”.”USRID”=”USRINFO”.”PVID") INNER JOIN 
“dbo”.”USRINFO” “USRINFO_1” ON 
“ORDERS”.”AUTHBYUSRID"="USRINFO_1"."PVID”) LEFT OUTER JOIN 
“dbo”.”ORDER_ENTRY_MODIFIERS” “ORDER_ENTRY_MODIFIERS” ON 
“ORDERS”.”ORDERID”=”ORDER_ENTRY_MODIFIERS”."ORDERID”) INNER JOIN 
“dbo”.”vPatientProfile” “vPatientProfile” ON 
"ORDERS”."PID"="vPatientProfile"."pid”}

WHERE "ORDERS"."XID" = 1000000000000000000 --CURRENT VALUE ONLY 
WITHOUT AUDIT

AND "ORDERS"."STATUS" IN ('S','H') --IN PROCESS or ADMIN HOLD

--AND "ORDERS"."TYPE" = 'S' --UNCOMMENT THIS LINE TO FILTER ONLY FOR 
SERVICE ORDERS IF DESIRED

ORDER BY "vPatientProfile"."lastname", "vPatientProfile"."pid", 
"ORDERS"."ORDERID"

  Uncomment the line that starts "--AND “ORDERS”.”TYPE” = ‘S’ to add 
the Order Type of Service and only list Services orders. This filters for 
orders typically set to transfer to the Billing component.

Active Directory enhancements
With this update, Active Directory is modified to take advantage of improved 
directory services functionality and stability.

If you have more than 1000 users or groups in your Active Directory, GE 
recommends placing all Centricity Practice Solution users into a single 
organizational unit (OU) and configuring the application to use that OU for 
domain authentication. Adding the users to an OU optimizes performance 
when querying Active Directory for login and security. You can create 
additional OUs beneath the top-level OU for more grouping flexibility. 

 Make sure that the OU is configured at the root of the search path for 
optimal search performance.

An enhancement to the Reports, Administration, and ServerSetup pagesize 
property now retrieves and displays up to 30,000 rows when the application is 
authenticating users and user groups. If the Active Directory is larger than 
30,000 user/groups, any results above 30,000 are truncated. 

 If a user is in multiple security groups, only the first instance of that user is 
displayed, which may reduce the overall number of users displayed to less 
than 30,000 users.
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Previously, Active Directory returned a maximum of 1000 rows from any 
query. If the Active Directory contained more than 1000 groups or users, only 
the first 1000 users and 1000 groups were displayed. CISDB00025456

For more information on setting up Active Directory, refer to the Microsoft 
documentation at http://www.microsoft.com/windowsserver2003/
technologies/directory/activedirectory/default.mspx. #15044

Setting up User/Group Security in Server Setup
These changes have the following impact on Server Setup Security option 
settings. Server, Domain, and Other Domain options are essentially 
unchanged, however, if your Other Domain and Organizational Unit 
specifications begin with WinNT:// or IIS://, change them to a domain or node 
name. Domain names in the Domain, Other Domain, and Organizational Unit 
fields must have an Internet suffix (such as .com or .LOCAL). The syntax for 
organizational unit names is [Domain.suffix/Organizational Unit]. 

Enter an Organizational Unit Active Directory path as a series of directory 
nodes separated with a single forward slash character ('/'). The node sequence 
must start at the root domain node level (see sample screen below). 

Authenticating across multiple domains
If logon credentials must be authenticated across multiple Active Directory 
domains, a two-way trust relationship is required between the domains, for 
example:

Trust is required– 

 Server authentication: if client is on domain X and database server on 
domain Y, two-way trust is required between domains X and Y.

http://www.microsoft.com/windowsserver2003/technologies/directory/activedirectory/default.mspx
http://www.microsoft.com/windowsserver2003/technologies/directory/activedirectory/default.mspx
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 Domain authentication: if client is on domain X, and domain server on 
domain Y, two-way trust is required between domains X and Y.

Trust is NOT required– 

 Server authentication: if client is on domain X, and database server on 
domain X, trust is not required.

 Domain authentication: if client on domain X, and domain server on 
domain X, trust is not required.

Users who log in to workstations using a local account or another account not 
associated with a domain (or trusted domain) will be denied access to the 
application if domain-level security is enabled. For example, a user attempting 
to log in to the application from an uncontrolled home or personal PC will be 
denied access. Server-level security authentication scenarios remain 
unchanged from previous Centricity Practice Solution service packs and/or 
Practice Management 2004. #17577

Using Organizational Unit for Security Source
The Organizational Unit option identifies the level within your Active Directory 
at which searches for users and groups begin. Searches for users or groups 
return only items located at or below the Organizational Unit you specify. 

For example, consider the following Active Directory structure:

Invalid/unsupported characters for Active Directory
The following characters should not be used in naming containers, groups, 
and users, or in passwords. These characters either have special meaning to 
the Active Directory search engine or are listed as unsupported. If you use 
these characters in naming, your Active Directory users and groups may not 
display or behave properly. SPR#17947, 17922, 17923 

Active Directory hierarchy Security Source setting for Organizational Unit

Root Domain When set at this level for Users, all UserNames 
are available (1,2,3,4,5). 
When set at this level for Groups, all 
GroupNames are available.

UserList1
UserName1
UserName2

When set at this level for Users, only User 
Names 1 and 2 are available.

UserList2
UserName3
UserName4

GroupList1
GroupName1
GroupName2

When set at this level for Groups, only 
GroupNames 1 and 2 are available.

GroupList2
GroupName3
GroupName4

UserName5
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Active Directory support no longer resides in MBCXP.DLL
Important!! The MBCXP library is shared for an instance of SQL 2005. Since 
this service pack changes MBCXP80.DLL to support enhancements to Active 
Directory, if your instance of SQL Server 2005 supports multiple CPS 
databases, you must upgrade ALL databases in the target instance to Service 
Pack 5 at the same time. Earlier versions will not be able to authenticate login 
credentials using the new MBCXP library.

Since Active Directory support no longer resides within the MBCXP.DLL, after 
you install this service pack you need not restart SQL Server after making 
security path option changes in Server Setup (while the CPS application is shut 
down). Changes are effective immediately when Server Setup quits. 

However, if you change security path options while an instance of the 
application is running, you must restart that instance to make the changes 
effective. SPR 17891

Configure SQL Server 2005 for performance / uptime
The following configurations are required to optimize Centricity Practice 
Solution performance and up time on Microsoft SQL Server 2005. For best 
results, configure these settings before running the application for the first 
time.

!!! These configurations work together and are REQUIRED.

 Follow GE recommendations for database server RAM, disk arrays, and 
disk and database file layout . See “Database server” on page 42.

 For security purposes, DO NOT run the SQL Server instance on the same 
account as IIS. Instead, SQL Server should log on as a dedicated 
administrator account (not the Local System account)

 Add the -g startup flag. See “Add -g (singledash) startup flag” on page 14.

 Use AWE to allocate memory and set Max Server Memory to 1 GB less 
than total system memory. See “Set AWE and Max Server Memory” on 
page 15.

space : colon ( left parenthesis

, comma ; semicolon ) right parenthesis

+ plus sign | vertical bar \ back slash

“ quotation mark = equal sign / forward slash

‘ apostrophe * asterisk < less than symbol

[ left bracket ? question mark > greater than symbol

] right bracket @ at sign & ampersand

# pound sign ! exclamation point ~ tilde
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 Enable Lock Pages in Memory OS security setting. See “Enable Lock 
Pages in Memory option” on page 15.

 Edit the boot.ini file to enable PAE. See “Edit boot.ini file to enable PAE on 
a Windows 2003 server” on page 16.

 Running the client on the database server? You must select (local) 
named pipes and TCP/IP protocol for remote connection when setting up 
SQL Server, otherwise you may see a named pipes error when you launch 
the application. See “Configure SQL Server 2005 to run the client on the 
server” on page 16. 

Recommended and required configurations

Add -g (singledash) startup flag
Adding the -g startup flag specifies the amount of virtual address space that 
SQL Server will leave available for memory allocations within the SQL Server 
process.

1 Select SQL Server 2005 Services. 

2 Right-click on the SQL Server instance and select Properties. 

3 Select the Advanced tab. 

4 Select Startup Parameters and scroll to the right to the end. 

5 Enter one of the following with no space before or between the 
characters:

;-g512

or

;-g1024

If you use the -g1024 setting, you must also use the /3GB switch as shown 
in Edit boot.ini file to enable PAE on a Windows 2003 server.

6 Click OK. 

7 Select the Logon tab.

8 Set SQL Server to log on as a dedicated Administrator account.

 This will require a restart of the SQL Server instance and agent. 
Complete other configurations before rebooting. 
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9 Stop the mssqlserver service and verify the startup parameters include 
the -g command line by opening the ERRORLOG file. The default 
ERRORLOG location is:
..\Program Files\Microsoft SQL 
Server\MSSQL.1\MSSQL\LOG\ERRORLOG

Set AWE and Max Server Memory
Address Windowing Extensions (AWE) allows programs to address more 
memory than the 4 GB that is available through standard 32-bit addressing. 
The range of memory in excess of 4 GB is exposed to the memory manager by 
Physical Address Extensions (PAE). See “Edit boot.ini file to enable PAE on a 
Windows 2003 server” on page 16.

1 Right-click on the server name in Microsoft SQL Server Management 
Studio and select Memory.

2 Check Use AWE to Allocate Memory. 

3 Set Max Server Memory to 1 GB less than total system memory.

Enable Lock Pages in Memory option
This option improves performance by preventing the operating system from 
swapping SQL Server memory pages to disk and allowing SQL Server to 
reduce its working set when the OS requires it to do so. 

From the database server:

1 On the Start menu, select Run. 

2 In the Open field, type
gpedit.msc 

3 On the Group Policy console, expand Computer Configuration, then 
expand Windows Settings.

4 Expand Security Settings, then expand Local Policies.

5 Select the User Rights Assignment folder. The policies display in the 
Details pane. 

6 In the Details pane, double-click Lock Pages in Memory.

7 In the Local Security Policy Setting window, click Add.

8 In the Select Users or Groups window, add the user account that will run 
sqlservr.exe.

[timestamp] Server Registry startup parameters:

[timestamp] Server -d D:\Program Files\Microsoft SQL º\DATA\master.mdf

[timestamp] Server -e D:\Program Files\Microsoft SQL º\LOG\ERRORLOG

[timestamp] Server -l D:\Program Files\Microsoft SQL ºDATA\mastlog.ldf

[timestamp] Server -g 1024
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 Changes to these settings will require a restart of the SQL Server instance.

Edit boot.ini file to enable PAE on a Windows 2003 server
This setting enables Physical Address Extensions (PAE) to help your server take 
advantage of memory over 4 GB on a Windows 2003 server.

1 Click Start in the Windows task bar.

2 Right click on My Computer and select Properties. 

3 Select the Advanced tab.

4 Click Settings for Startup and Recovery.

5 Click Edit . The boot.ini file is opened. Open the file in a text editor such as 
NotePad and add one of the following commands at the end of the 
operating systems configuration line used to boot and run SQL Server:

If you used the -g512 command line, or if you have over 16GB of memory 
on your server:

/PAE

If you used the -g1024 command line:

/3GB /PAE

Example:

[boot loader]
timeout=30
default=multi(0)disk(0)rdisk(0)partition(3)\WINDOWS
[operating systems]
multi(0)disk(0)rdisk(0)partition(3)\WINDOWS="Window
s Server 2003, Enterprise" /noexecute=optout /
fastdetect /3GB /PAE

6 Save the file.

7 Click OK on each open dialog box.

8 Reboot the server.

Configure SQL Server 2005 to run the client on the server
When the Centricity Practice Solution client application and SQL Server are 
installed on the same machine, SQL Server must use named pipes protocol to 
transfer data. This also applies to extended stored procedures. 

The best practice is select (local) named pipes and TCP/IP protocol for remote 
connection when setting up SQL Server, otherwise you may see a Name Pipes 
error when you attempt to launch the application.

Configure Services and Connections
First configure surface area...

1 Open Microsoft SQL Server 2005 > Configuration Tools and select SQL 
Server Surface Area Configuration.
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2 Under Configure Surface Area for Localhost, click Surface Area 
Configuration for Services and Connections.

3 In the component tree, expand SQL Server 2005, then under Database 
Engine, select Remote Connections. Options display in the pane to the 
right.

4 Select Local and Remote Connections and then select the sub-option 
Using both TCP/IP and named pipes.

5 Click Apply. A Connections Settings Change Alert warns you that changes 
to connection settings will not take affect until you restart the database 
engine service. 

6 Click OK to close the dialog, then click OK on the Surface Area 
Configuration for Services and Connections window. The main Surface 
Area Configuration window returns.

Now configure features...

1 In the main Surface Area Configuration window, select Surface Area 
Configuration for Features.

2 In the component tree, expand MSSQLServer, then under Database 
Engine, select the following options and check the displayed option(s) to 
the right to enable.

 Ad Hoc Remote Queries 

 CLR Integration 

 DAC 

 OLE Automation

 Xp-cmdshell 

3 Click Apply, then click OK on the Surface Area Configuration for Features 
window. The main Surface Area Configuration window returns.

Next, stop and start SQL Server 2005...

1 In the main Surface Area Configuration window, click Surface Area 
Configuration for Services and Connections.

2 In the component tree, expand MSSQLServer, then under Database 
Engine, select Service. 

3 In the options pane to the right, click Stop. When the Start button appears, 
click Start .

4 Click OK and close the Surface Area Configuration window.

Upgrading PM 2004 customers: Configure Application Logon for SQL Server 2005
If you plan to restore a backup of the PM application to a new instance of SQL 
Server 2005 before upgrading to Centricity Practice Solution, you should 
update the Application Logon for the current database in SQL Management 
Studio.
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 SQL Server uses the Application Logon user to access the Centricity 
Practice Solution database when launching the client application. 

1 From the Windows Start menu, select Programs | Microsoft SQL Server 
2005 | SQL Server Management Studio. Click Connect .

2 Double-click Security to expand it and then select Logins.

3 Right-click on the Logins folder and select New Login.

4 On the Login - New > General screen, create a new user with the same 
name and credentials you used for the previous SQL Server Application 
Logon user. 

5 For Default Database, select the database you plan to upgrade, and then 
click OK. The new user displays in the Logins list.

6 Double-click the new Application Logon user in the Logins list.

7 Click User Mapping in the left navigation list. 

8 In the Users Mapped to this Login list, select the relevant database. The 
user name appears in the User column.

9 In the lower Database Role Membership list, check dbo_owner and click 
OK.

10 Exit SQL Server Management Studio. The Application Logon now has 
permissions needed to update the database. After upgrade you will return 
to SQL Server Management Studio for a final step. See step 11 below. 

11 Upgrade the database to Centricity Practice Solution and Service Pack 5.

!!! To upgrade your PM database to Centricity Practice Solution, you must 
install from CD-ROM installation disks. You cannot upgrade by applying 
the service pack as described below. To obtain an upgrade kit, contact 
your GE representative or your value- added reseller. 

For detailed upgrade instructions, see the Centricity Practice Solution 
product release notes and Server Setup online help accessible from the 
CD. 

12 After upgrade, launch SQL Server Management Studio, double-click 
Security to expand it and then select Logins.

13 In the Logins list, double-click the Application Logon name.

14 On the Login Properties screen for the user, click User Mapping in the left 
panel. 

15 In the Users Mapped to this Login list, check the relevant Database for this 
login.

16 In the Default Schema column for the listing, change dbo_owner to the 
Application Logon name, or click the ... button and enter the name in the 
Object field.
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17 Click OK and exit SQL Server Management Studio. This updates the 
Application Logon user correcting any potential differences between 
dbo_owner in SQL Server 2000 and SQL Server 2005.   

Single-user Demo Database cannot be upgraded
SQL Express is only supported as a platform for a single-user installation of the 
Demo Database. Databases hosted on SQL Express cannot be upgraded. You 
must create a new Demo Database after upgrading. If you used a Demo 
Database to create clinical content, export it as clinical kits prior to upgrade 
and then reimport the kits into your new Demo Database. 

 If you upgrade a database from CPS SP2, you may be prompted to reboot 
your client machine, which can occur if certain files are locked during the 
upgrade. 

Download the service pack

!!! As a precaution, always back up the Centricity Practice Solution database 
before you download and apply a service pack.

Back up the Centricity Practice Solution database

1 From the Windows Start menu, select Programs | Microsoft SQL Server 
2005 | SQL Server Management Studio. Click Connect .

The Object Explorer window displays.

2 Expand SQL Server Agent . 

 To expand SQL Server Agent , click the plus sign (+) next to it.

3 Under SQL Server Agent , click Jobs.

A list of jobs displays in the right pane.

4 Right-click on the backup job for your Centricity Practice Solution 
database.

 Example: Backup Database - CPS.

5 Select Start Job at Step.

The Start Job window displays.

6 Click Start .

You will receive confirmation of success or failure of the backup within this 
Window.

7 Click Close.

8 Exit SQL Server Management Studio.
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Download the service pack

1 Close the Centricity Practice Solution client on all computers.

2 On the server where Server Setup application is located, log in to 
Microsoft® Windows as the Administrator.

3 Launch Server Setup.

4 Select Download Available Updates and then click Next . 

The Web site installation window displays the Centricity Practice Solution 
Web sites you have installed.

5 Select the Web site you want to update, then click Next . 

The Download Available Updates window displays links to updates 
available for the selected web site.

6 Click the service pack release notes link to download the notes document 
(in Adobe PDF format) and review them.

7 Do one of the following:

 To begin downloading the service pack, click the service pack link. 

 To return to the previous window, click Back. 

The Downloading Update window displays the product version number, 
download location, total file size, and download progress.

 The time to download a service pack varies depending on available 
network bandwidth. Slow progress does not mean that the program is 
not downloading. The installer window will reappear once the 
download is complete.

8 Do one of the following:

 If the download is successful, the Downloading Update window 
displays “Completed” as the status. Go to step 9.

 If the download is unsuccessful, the Downloading Update window 
displays "Download Failed. Operation Aborted" as the status. Go to 
step 10.

9 If the download is successful, click OK and then click Exit , then Finish.

 Server Setup closes and re-opens. Proceed to the next section, “Install 
the service pack on a server” on page 21.

 Click Exit to close Server Setup.

Server Setup closes and you can restart it when you are ready to apply 
the update. 

10 If the download is unsuccessful, click OK, and then click Cancel to close 
the Downloading Update window. Do one of the following:

 Click Back to return to the previous Server Setup window.

 Click Exit to stop the download process.
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 If multiple attempts to download fail, contact Centricity Practice 
Services at 888.436.8491 option 2.

Install the service pack on a server
Before applying the service pack, take the following steps:

Stop the MIK service
If you are running Millbrook Integration Kit (MIK), complete these steps before 
you install the service pack on your server(s):

1 Start Server Setup.

2 Select Advanced Options, then click Next . 

3 Select Millbrook Integration Kit Configuration, then click Next .

!!! If your SQL Instance name includes a machine name such as 
"VSH-MIS06\SQL2005", manually add the end of the SQL instance 
name to the value in the Server Name field wherever it displays to 
avoid a connection error. SPR17894

4 Select the server where MIK is installed.

5 Click Stop.

Back up your current MIK configurations
If you are running Millbrook Integration Kit (MIK), complete these steps before 
you install Service Pack 5 on your server(s):

1 Click Start then choose Run.

2 Type regedit and press Enter. 

!!! Do not do this step on your own if you are unfamiliar with regedit . Get 
help from a qualified network/IT engineer.

3 Export the following keys to the Desktop as backup:

HKEY_LOCAL_MACHINE\SOFTWARE\AHC

HKEY_LOCAL_MACHINE\SOFTWARE\GE

HKEY_LOCAL_MACHINE\SOFTWARE\GE Healthcare

4 Close regedit.



22 Revision D October 2009

GE Healthcare Centricity Practice Solution SP5 Release Notes

Install the service pack on a server

!!! To avoid errors, once you have logged on to the database in Server Setup 
and reached the Licensing screen, you must stop IIS services before 
starting the service pack installation. You will restart services when 
upgrade is complete.

1 On the server Desktop, double-click the CPS 2006 Launch icon. SPR17889, 
17957

!!! DO NOT click the Desktop Server Setup icon. This may prevent 
MBCXP.DLL from being properly registered. SPR17889, 17957

 If CPS 2006 Launch is not on the Desktop, search for and double-click 
launch.exe. (Default location is at the root of the staging directory.)

2 On the launcher Welcome screen, select Install/Update Server, then click 
Server Setup. Server Setup opens.

3 In Server Setup, select Apply Available Updates then click Next .

The Web site installation location window displays the Centricity Practice 
Solution Web sites you have installed.

4 Select the Web site you want to update then click Next . The Update an 
Existing Web Installation window appears.

5 Click Next .

The Server Logon window opens. 

!!! If your SQL Instance name includes a machine name such as 
"VSH-MIS06\SQL2005", manually add the end of the SQL instance 
name to the value in the Server Name field wherever it displays to 
avoid a connection error. SPR17894

6 Enter your SQL Server administrative user name and password if 
necessary and click Next . 

7 To begin the installation, click Next . The End User License Agreement 
window  displays.

8 Accept the license agreement and click Next . The License Code window 
displays.

9 Leaving the Server Setup application open, go to START > Control Panel > 
Administration Tools > Services.

10 Select IIS Admin Server and click Stop.

11 Click Yes when prompted to shut down additional services.

12 Return to Server Setup and click Next on the License Code window and 
follow the instructions on the screen.
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A window displays update progress. When the update is complete, the 
Return and Exit buttons display along with the message, "Action 
completed!"

13 Click Return. The Choose Setup Option to Perform window displays.

14 Select Advanced Setup Options, then click Next .

The Choose Advanced Option to Perform window displays.

15 Select Utilities, then click Next .

The Choose Paths window displays.

16 Click Next .

The Server Logon window displays.

17 Enter your SQL Server Administrative logon name and password, then click 
Next .

18 To update MBCXP do the following:

 If your practice has only one database, skip to Step 17.

 If you see several databases in the database selection window, select 
the latest database version (such as 8.0.144), then click Next .

19 Click Update MBCXP.

20 Click Set User Defaults.

21 Click Exit then click Yes in response to the confirmation message.

22 Close the CPS 2006 Launch window.

23 IMPORTANT: Restart IIS and SQL Server. When you have completed all 
steps for updating the server, go to START > Control Panel > 
Administration Tools > Services and do the following:

 Right-click on IIS Admin Server and select Restart and then confirm. 
This restarts IIS services.

 Right-click on SQL Server (SQL2005) and select Restart and when you 
are asked if you want all services started, click Yes. 

This service pack replaces the shared stored procedure MBCXP.DLL as 
part of the enhanced integration with Active Directory. If you do not 
restart the SQL 2005 service, you may see an application error when 
attempting to login the application.

24 (JOBS.TXT users only) Restore the JOBS.TXT file and Web site Source folder 
to the Web site previously described on page 7.

Using InSite 2.0
InSite 2.0 is a serviceability tool that permits the Centricity Practice Services 
team to provide remote support to the application server.

If you have a prior install of Centricity Practice Solution, you may already have 
InSite 2.0 installed on your server or DTS. Starting with Service Pack 4, InSite is 
no longer installed by the service pack.
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Uninstall Insite 2.0
If you choose to uninstall InSite 2.0, you can uninstall the application without 
uninstalling Centricity Practice Solution by following these steps:

1 Click Start > Control Panel, and open Add or Remove Programs.

2 Select InSite 2.0.

3 Click Uninstall. The uninstall wizard launches, and will guide you through 
the uninstall process.

Install MIK Service Pack 5

!!! Only perform this procedure if you have the Millbrook Integration Kit (MIK). 
DO NOT uninstall MIK.

1 Navigate to the  location of the MIK installer (default is  
C:\CPS_2006_Staging\CPS_2006_MIK) and double-click setup.exe. 

This message displays: 

This setup will perform an upgrade of CPS_2006_MIK. Do you want 
to continue?

2 Click Yes. 

InstallShield will open and step you through the upgrade. Select all the 
defaults until you see InstallShield Wizard Complete.

3 Click Finish.

Install service pack on workstations
If you licensed the PM module only, skip to “Install the service pack to 
workstations” on page 26. 

If you licensed the Chart module and are using LinkLogic, update client 
workstations in the following order:

1 “Update Data Transfer Station (DTS)” on page 25.

2 “Update LinkLogic on the server” on page 26. 

3 Update all other client workstations. See “Install the service pack to 
workstations” on page 26.

!!! DO NOT update any client workstations until you have updated the Data 
Transfer Station (DTS) and updated LinkLogic. 

Before beginning, back up your directories. If you have customized files 
in the LinkLogic Config\Standard directory, contact Centricity Practice 
Services at 888-436.8491 x2, before completing this section.
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Update Data Transfer Station (DTS)
When you apply this service pack on a workstation, the files in the Client 
directory are overwritten, including the emr.ini file that contains your DTS 
configuration. Before you update the client on the DTS, you must back up this 
file to preserve the current DTS configuration so you can continue processing 
data transfers for lab results, transcriptions, and other documents without 
interruption.

Install the service pack to a DTS workstation

1 Stop the Data Transfer Station.

2 Navigate to the Centricity Practice Solution/Client directory and copy 
the emr.ini file to your Desktop.

3 Start Centricity Practice Solution on the workstation.

The Product Installer page displays.

4 Verify that your URL points to the correctly updated Web page.

5 Click the Update link (in red) for CPS_2006_Client .

The Installer will detect that an older version of the client application exists 
and ask you to uninstall it .

6 Click Here to uninstall. The removal process uninstalls the application.

 When you uninstall the client application, you do not see a progress 
indicator for the uninstallation. This does not mean that the program is 
not responding or terminated, however. DO NOT attempt to end this 
process.

7 When the uninstall process is complete, click Here to continue to the Client 
Setup page.

8 Click Install to download the installer. The installer window displays. 

 The time to download a service pack varies depending on available 
network bandwidth. Slow progress does not mean that the program is 
not downloading. The installer window will reappear once the 
download is complete.

9  On the installer Welcome screen, click Next , and then click Next on all 
subsequent screens to accept default settings. 

10 When the installation is complete, click Here to return to the Product 
Update page and close the window to exit.

11 When the client update on the DTS workstation is complete, copy the 
emr.ini file from the Desktop back to the client directory, overwriting the 
newly installed file. 
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12 Update Active Directory Group Names and LinkLogic (next sections) 
before restarting the workstation.

Update LinkLogic on the server 
If you are using LinkLogic and Data Transfer Station (DTS) to exchange patient 
demographic and clinical data with external systems such as labs and 
transcription services, take the following steps on the machine where DTS is 
running. This will ensure that the service pack update is properly applied to the 
LinkLogic configuration.

1 Exit Data Transfer Station and confirm that it is not running on the 
workstation.

2 Navigate to the LinkLogic Standard folder (usually C:\Program 
Files\Centricity Practice Solution 2006 \llogic\Config\Standard).

3 Right-click on the Standard directory and select Copy.

4 Navigate to the remote LinkLogic Config directory on your database/Web 
server (such as \\<Server_name>\llogic\<Database_name>\ Config).

5 Right-click on the Config directory and select Paste.

When asked if you want to replace the folder. click Yes to All.

6 On the DTS, navigate to the LinkLogic Upgrade folder (usually C:\Program 
Files\Centricity Practice Solution 2006\llogic\Config\Upgrade).

7 Right-click on the Upgrade directory and click Copy.

8 Navigate to the remote LinkLogic Upgrade directory on your database 
server (such as \\<Server_name>\llogic\<Database_name>\ Upgrade).

9 Right-click on the Upgrade directory and click Paste.

When asked if you want to replace the folder. click Yes to All.

10 Restart Data Transfer Station.

Install the service pack to workstations

 When upgrading a client on the database/Web server, you may be 
required to reboot the machine during the upgrade process.

!!! Microsoft Vista users: if you have previously installed Service Pack 4 (build 
245) on a Microsoft Vista workstation, you must first manually uninstall the 
existing Centricity Practice Solution application using Add/Remove 
Programs before upgrading to the latest version of Service Pack 5 on that 
workstation.

1 Start Centricity Practice Solution on a workstation. The Product Installer 
page displays.
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 If you are installing the service pack on a Vista workstation, you must 
run the Internet Explorer application as an administrator.

a Click Start > All Programs. The Programs menu displays.

b Right-click the Internet Explorer shortcut and click Run as 
Administrator.

c Type your user name and password in the User Account Control dialog 
and click Submit . The Internet Explorer application opens.

If you are an administrator, click Allow on the User Account Control 
dialog.

2 Verify that your URL points to the correctly updated Web page.

3 Click the Update link (in red) for CPS_2006_Client .

The Installer will detect that an older version of the client application exists 
and ask you to uninstall it .

4 Click Here to uninstall. The removal process uninstalls the application.

 When you uninstall the client application, you do not see a progress 
indicator for the uninstallation. This does not mean that the program is 
not responding or terminated, however. DO NOT attempt to end this 
process.

5 When the uninstall process is complete, click Here to continue to the Client 
Setup page.

6 Click Install to download the installer. The installer window displays. 

 The time to download a service pack varies depending on available 
network bandwidth. Slow progress does not mean that the program is 
not downloading. The installer window will reappear once the 
download is complete.

7  On the installer Welcome screen, click Next , and then click Next on all 
subsequent screens to accept default settings. 

8 When the installation is complete, click Here to return to the Product 
Update page and close the window to exit.

9 Do the following:

 If you have Active Directory groups with mismatched Group Names, 
you must “Update Active Directory Group Names” on page 28.

 If your Active Directory group names all match, when installation is 
complete, restart Centricity Practice Solution on the workstation.



28 Revision D October 2009

GE Healthcare Centricity Practice Solution SP5 Release Notes

Update Active Directory Group Names
Take the following steps only if you have Active Directory Groups with 
Group Name and Pre-Windows 2000 Group Name that do not match. 

!!! If you do not take these steps you will need to reassign security 
permissions to these groups after the update.

Update Active Directory Group Names

1 In Active Directory, create a user that is assigned to all groups where the 
group names do not match.

2 Log in once to the application as that user and then close the application.

The SecurityGroup table is automatically populated with all groups 
associated with the user when you log in.

3 On the database server, open Server Setup.

4 Select Advanced Setup Options and then click Next . 

5 Select Utilities and then click Next . 

6 Confirm or enter the log file path and click Next . The setup directory path 
is not required.

7 On the Server Logon window, if necessary, enter the server name 
(including the optional SQL Server instance name if applicable), user name, 
and user password for the server where the Centricity Practice Solution 
database is located. Click Next .

8 On the Available Databases window, select the database to configure and 
click Next . If only one database is available, this window does not display.

9 On the Utilities window, click Security.

10 On the Security Options window, click Finish. This updates and 
synchronizes your security settings. #18350

Configure DTS to run as a Windows service
Data Transfer Station (DTS) can be configured to run as a Windows Service. 
This allows the DTS administrator to start, stop, and check the status of the 
DTS from the Administrative Tools > Services control panel. If the DTS crashes, 
the new service restarts it automatically. SPR17892 

!!! You can only run one instance of DTS as a service per machine. GE 
recommends that you install each DTS instance to a separate qualified 
workstation or server.

To access this feature, you will configure an administration tool “XYNTService” 
that wraps the DTS in a layer controlled from Windows Administrative Tools or 
the Control Panel. This wrapper includes an executable and an .INI file that 
defines the parameters used to start and stop the application as a service.
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 Running DTS as a Windows service differs in Vista environments.

Install the LinkLogicDTS service
1 Navigate to the Centricity Practice Solution\Client directory.

2 Double-click the dts_install.cmd file. 

 If you are in a Vista environment, right-click the file and select Run as 
administrator. Click Continue at the User Access Control (UAC) dialog.

Configure the service to run under a user account

!!! DO NOT use this configuration on Windows Vista Operating System. You 
cannot set up the DTS console in Monitor mode on Vista. See “Disable DTS 
UI interaction to the desktop in Vista” below.

For processes created by the service to access a specific user's settings such 
as mapped network drives, you must configure the service to run under a user 
account.

1 On the Control Panel/Administration tools, click Services.

2 In the installed services list, double-click LinkLogicDTS.

3 In the Services Properties window, select the Log On tab.

4 Check Local System Account and Allow service to interact with Desktop.

5 Click OK.

Disable DTS UI interaction to the desktop in Vista
For Vista users, an administrator must disable all DTS user interface 
interactions to the desktop after installing the LinkLogicDTS Windows Service. 
After starting the LinkLogicDTS Windows Service, perform the following steps:

1 Click Start > Control Panel | Administrative Tools > Services. 

2 Right-click the LinkLogicDTS service and select Properties. 

3 Select the Log On tab and clear the check box that allows interaction with 
the desktop.

Start/stop the LinkLogicDTS service 
The LinklogicDTS service starts automatically by default when you reboot the 
computer. You can also start and stop the service from the Control Panel or 
Administrative Tools using the Services option.
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Disable LinkLogic/DTS startup dialogs
To facilitate auto-restart of the Data Transfer Station, a new option on the LinkLogic > 
Defaults screen in Setup > Settings > LinkLogic disables all LinkLogic/DTS dialogs at 
startup, including user logon/password and a variety of error messages and warnings.

This option is unchecked by default. If you are running the LinkLogicDTS 
service, check this option to permit the DTS to restart automatically without 
user intervention. However, if the DTS cannot restart successfully, temporarily 
uncheck this option so you can see an error or warning that may be 
preventing restart.

 When configured for fully automatic restart, the DTS will restart in the 
event of a crash, but not a hang. If the DTS process is active but stops 
processing, resulting in a "process hang", you must stop it manually in the 
Windows Task Manager, or by using the stop service feature in the 
Windows Services control panel.

Uninstall the LinkLogicDTS service
1 Stop the LinkLogicDTS service. 

2 Navigate to the EMR client installation directory.
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3 Double-click the dts_uninstall.cmd file. 

If you are in a Vista environment, right-click the file and select Run as administrator. 
Click Continue at the User Access Control (UAC) dialog.18083

Change the LinkLogicDTS service 
The default settings for the service do not need to be changed for most 
implementations. The following path and process settings can be changed if 
necessary.

Edit working path directory
When you set up DTS to run as a service you might need to edit the 
XYNTService.ini file on the DTS workstation. You will find the XYNTService 
executable files in the Centricity Practice Solution folder on the DTS 
workstation, where the ml3dts.exe file is installed. In addition to the 
XYNTService.exe file, you will also find the XYNTService.INI associated 
configuration file in the Centricity Practice Solution\Client folder.

These are the default settings of the XYNTService.INI file:

[Settings]

ServiceName=LinkLogicDTS
CheckProcessSeconds = 30

[Process0]

CommandLine=C:\Program Files\Centricity Practice 
Solution\Client\ml3dts.exe -u “http://localhost <dbname>”Instance=1

 This is the default path. If your install path is different, you must modify 
this value. To prevent DTS from displaying the Login/Password dialog, 
make sure you use the “-u” switch for auto-restart mode.

WorkingDir= C:\Program Files\Centricity Practice 
Solution\Client
PauseStart= 1000
PauseEnd= 1000
UserInterface = Yes

 Vista users must change the UserInterface value from Yes to No.

Restart = Yes

 For additional information about these parameters, see the Centricity 
Practice Solution online help.
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Change process settings

1 To set how often the service checks the DTS, change the 
CheckProcessSeconds value. Default is 30 seconds.

2 For PauseStart, set how long the service waits after starting the current 
process (and before starting the next process). Default is 1000 
milliseconds.

This is useful when the next process depends on the previous process. For 
example, the second process has to "connect" to the first process in such 
a way that it does not run until the first process is finished with 
initialization.

3 For PauseEnd, set how long the service waits before it terminates the 
process it started. This gives the process a chance to clean up and shut 
itself down. Default is 1000 milliseconds.

4 To display the DTS user interface, set UserInterface to Yes.

!!! On Microsoft Windows Vista operating system, set UserInterface to 
No.

5 Confirm that Restart is set to Yes. This tells the service to restart the DTS in 
the event of a crash.

Known issues in this service pack

Custom zoom levels for report previews
An improvement opportunity detected in Centricity Practice Solution 2006 
Service Pack 3 (8.0.3) was reported as resolved in Service Pack 4. The issue was 
actually resolved in Centricity Practice Solution v 9. The issue involves setting 
custom zoom levels when previewing reports.

Workaround: None. Use one of the preset zoom levels. SPR# 23039

Reports module occasionally displays a blue box over the controls
Starting with CPS 2006, when the application is skinned, a blue box 
occasionally displays over the Forward and Back buttons in the Reports 
module. The buttons are still active; they simply have a skin over them that 
hides them from view. 

Workaround 1: Click the blue box and the button functions correctly. This 
typically also removes the blue skin. 

Workaround 2: Turn off skinning:

1 In the Windows Explorer, go to C:\Program Files\Centricity Practice 
Solution 2006\Client.

2 Right-click on the emr.ini file and select Open with. 

3 Select Notepad and click OK.

4 Under [Logician Private], add the following line:
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DOSKINNING=0. 

5 Save and close the file.

Allocation sets do not automatically repopulate after reactivating 
insurance carriers
On the Insurance tab in Registration, clicking the check box to deactivate an 
insurance carrier for a patient removes the carrier’s default allocation set from 
the Allocation Set field, but reactivating the carrier does not repopulate the 
allocation set field.

Workaround: After reactivating the insurance carrier, click the binoculars 
button beside the Allocation Set field to select an allocation set. SPR# 
CISDB00024962

Dialog box color schemes may differ between XP and Vista operating 
systems
Because some dialog boxes are generated directly from the operating system, 
the look and feel of those dialogs may be different between Windows XP and 
Vista environments.

Workaround: Not applicable. The application functionality is not affected. 
SPR# CISDB00024907

Error when using the Webcam button in Vista
In Vista, User Account Control (UAC) prevents the Centricity Practice Solution 
from importing images via the Webcam button. 

 Make sure that you are using a Vista-compatible webcam before using 
any of the following workarounds.

Workaround 1: You can turn off User Account Control (UAC) for each user who 
must use a webcam. Turning off UAC must be performed by an administrator. 

1 Click Start > Control Panel | User Accounts > User Accounts. 

2 Click Turn User Account Control on or off.

A dialog displays, asking you to confirm the action.

3 Click Continue. The Turn on User Account Control (UAC) to make your 
computer more secure window appears.

4 Clear the Use User Account Control (UAC) to help protect your computer 
option.

5 Click OK. A dialog displays, asking you to restart your computer. 

6 Click Restart Now to immediately restart your computer, or Restart Later 
to continue working without restarting. 

Workaround 2: For webcams that can also function as digital cameras, you 
can use the Camera button instead of the Webcam button to capture images 
in Centricity Practice Solution. Refer to your camera’s documentation or 
manufacturer to determine whether your webcam will also function as a 
digital camera. 
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Workaround 3: You can capture images outside of Centricity Practice Solution, 
and import the images using the File or Clipboard button on the Acquire Photo 
window. SPR# CISDB00025039, 24606

Default website URL not visible in the CPS 2006 client installer in 
Vista 
During installation in Vista, the default website that you are using to install 
Centricity Practice Solution is not visible on the Enter Your website page in the 
CPS_2006_Installshield wizard. 

Workaround: Perform the following steps to view the default website. You 
must perform these steps for each workstation.

1 Launch Internet Explorer on the Vista client workstation.

2 Select Tools > Internet Options from the menu.

3 Select the Security tab.

4 Select the Trusted Sites zone and click Sites.

5 Enter the URL for the default CPS website in the Add this website to the 
zone field and click Add.

 Make sure that the Require server verification... option is not 
checked.

6 Click Close.

7 Click OK on the Internet Options window.

When you launch the application, you may receive message windows, 
asking if the ActiveX control is trusted. Click Yes if this message appears. 
SPR# 23909

Uninstall or Modify Centricity Practice Solution in Vista
To uninstall or modify the Centricity Practice Solution application, you must 
run the setup wizard as an administrator. 

Workaround 1: You can run the setup file as an administrator in a single 
session:

1 Click Start > All Programs > Centricity Practice Solution 2006.

2 Right-click CPS 2006 Setup.

3 Select Run as administrator.

Workaround 2: You can set the setup file to permanently run in administrator 
mode:

1 Click Start > All Programs > Centricity Practice Solution 2006.

2 Right-click CPS 2006 Setup.

3 Click Properties.
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4 On the Compatibility tab, select Run this program as an administrator in 
the Privilege Level area.

5 Click OK.

Workaround 3: Use the Add/Remove Programs function to uninstall or modify 
the application. Add/Remove Programs automatically assigns administrator 
privileges to the setup wizard. SPR# 22683, 17480

Incorrect instance of Microsoft Word displays for reports in Vista
If you have more than one instance of Microsoft Word open in Vista, opening a 
Chart report from Centricity Practice Solution may not trigger the correct 
instance of Word to become the active window.

Workaround: Close all instances of Word prior to opening a Chart report. 
SPR# 24003

Insert Symbol window only displays controls correctly when opened 
from Chart > Options > Preferences
The Insert Symbol window does not display the radio buttons or the action 
buttons when you access the Preferences window from Options > Preferences 
| Patient Charts > Quick Text > Insert Symbols button in any module other than 
Chart.

Workaround 1: Enter the search criteria in the Find Symbol field and press 
Enter. The window will display the search results and allow you to double-click 
the desired symbol.

Workaround 2: Access the Insert Symbol window via Chart module > Options 
> Preferences | Patient Charts > Quick Text > Insert Symbols button.

Printer drivers using COM may cause application crashes
Some manufacturers’ printer drivers that use COM have a known issue that 
prevents the correct shut-down of the driver. Before Service Pack 3, this 
caused the Centricity application to hang when using an affected printer 
driver. Starting with Service Pack 3, a change was introduced in the Centricity 
application to prevent the affected printer drivers from causing this problem 
by performing the print function from within a separate process, allowing the 
COM components to shut down without error. This coding change significantly 
reduces the rate of incidence for this issue in the application. The affected CPS 
modules are Billing, Accounts Receivable, Visits, and Balance Forward. The 
coding change was tested on the following printer drivers:

 HP Deskjet 3840 Series

 HP 1300 PCL 6

 Canon MP 160

 HP P2015 PCL 5e (non post script)

 HP Universal Printing PCL 5
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Address link maintained in the Internet Explorer when using Get 
Financial Information, Get Financial History, or Get Patient History
When using Get Financial Information, Get Financial History, and Get Patient 
History in Registration, the link to the address is maintained in the user’s 
Internet Explorer cache folder. Financial pages remain visible within the 
browser history list and must be removed manually.

 To remove the pages:

1 Open Internet Explorer.

2 Select View > Explorer Bar > History from the menu.

3 In the Today folder, navigate to the folder containing your historical CPS 
pages.

4 Right-click the pages you want to delete, and select Delete. 

The saved pages no longer appear in the history list.

Workaround 1: Change your Internet Explorer settings so that recently 
accessed sites are not saved in the history on computers that are shared 
publicly. To change your settings:

1 Open Internet Explorer.

2 Select Tools > Internet Options from the menu.

3 In the History area, change the Days to keep pages in history option to 0.

Alternatively, click Clear History to immediately clear your history file.

 If you do not change your Days to keep pages in history option to 0, 
you will need to clear your history each time you use Internet Explorer 
if you want to remove your viewed pages from the history file.

4 Click OK. 

Workaround 2: You can limit the users’ ability to access these pages by 
removing them from the security settings in the Administration component.

1 In Administration, navigate to System > User/Location Setup > Security | 
Main Menu > Registration > View Financial-Patient.

2 Change the security option as needed for the desired users. SPR# 21778, 
21848

MIK IDispatch error #19 received on creation of an external vendor 
outbound only interface
Configuring MIK to send A04 and A08 messages out of CPS without an 
inbound transaction path causes an error each time you save or update a 
patient. The errors are placed in the MIK.log file, and no HL7 files are placed in 
the specified folder for your newly-created or updated patient.

Workaround:

1 Add a false or dummy inbound path for the charges.
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2 Stop the MIK Service, and click Next to advance through all ServerSetup 
screens.

3 Restart the MIK Service, clicking Next to advance through all the 
ServerSetup screens.

4 Remove the dummy inbound path you created.

5 Stop the MIK Service, and click Next to advance through all ServerSetup 
screens.

6 Restart the MIK Service, clicking Next to advance through all the 
ServerSetup screens. SPR# 20991

Windows Server 2003 MS KB941569 creates an “Invalid User Name or 
Password” error
Workstations that download the Windows Server 2003 MS KB941569 update 
display an “Invalid User Name or Password” when you launch Centricity 
Practice Solution.

Workaround 1: The workaround may involve two issues:

1 Click Start, and open the Control Panel.

2 Double-click Add/Remove Programs.

3 Remove the Windows Security KB entries in the following order (must have 
“Show Updates” checked to see this entry to remove):

 KB941568

 KB942615 (forces restart)

 KB942840 (forces restart)

 KB941569

Workaround 2: If the issue persists, and if there are Application Event Viewer 
messages such as:

EVENT TYPE: ERROR

EVENT SOURCE: USERENV

EVENT CATEGORY: NONE

EVENT ID: 1030

DESCRIPTION: WINDOWS CANNOT QUERY FOR THE LIST OF GROUP POLICY 
OBJECTS. A MESSAGE THAT DESCRIBES THE REASON FOR THIS WAS 
PREVIOUSLY LOGGED BY THE POLICY ENGINE. FOR MORE INFORMATION, SEE 
HELP AND SUPPORT CENTER AT HTTP://SUPPORT.MICROSOFT.COM

1 Click Start > Run.

2 Type regedit in the Open field, and click OK. The Registry Editor 
appears.

3 Add the following registry key per MSKB 842804.
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 Only IT staff should edit the Windows registry.

4 Locate HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\Current Version\Winlogon.

5 Add the WaitForNetwork entry, if it is missing. To add the entry, perform 
the following steps:

a Right-click the Winlogon subkey.

b Select New.

c Click Dword Value.

d In the Value name box, type WaitForNetwork.

e Right-click WaitForNetwork, then click Modify.

  In the Edit DWORD Value dialog box, in the Value Data box, type 1, and 
then click OK.

f Close the Registry Editor. SPR# 20640

Query limitations prevent accurate display of problem codes
In Chart, if you enter problem code search criteria out of order, all the 
pertinent search results will not display. 

Workaround: Enter search criteria for finding problem codes in the following 
order to receive the correct information: 

 Active Diagnosis Contains [search criteria]

 Problem Type

 Active Diagnosis does not contain [search criteria] SPR# 16347

Invalid date evaluation not occurring for all methods of saving
Several fields in Registration do not respond with the verification message 
when you enter an incorrect date until you click the X to close Registration, 
then choose Yes on the Save dialog. The fields are:

 Additional tab / Authorizations Section / Release Pt Info Date

 Additional tab / Authorizations Section / Privacy Policy Date

 Additional tab / Authorizations Section / Benefit Assignment Date

 Financial tab / First Visit

Workaround: None. Double-check the entered dates before saving and 
closing Registration. SPR# 19704

Mouse scroll option not working in Encounter Types
You cannot use the mouse in Encounter types.

Workaround: Drag the slider bar in the right side to view the data. SPR# 17949
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MIK errors when processing incoming ADT messages
When the MIK receives an ADT message, an error message is generated within 
the log file that states “The Parameter is Incorrect” due to the new 
requirement that the PID-4 segment be populated with a value. Most external 
systems will not be sending this information to the CPS application, and thus it 
cannot be a required field by the MIK.

Administrator user causes performance degradation in Citrix 
Presentation Server 4.0
When using Citrix Presentation Server 4.0 to host the CPS 2006 application, 
CPS 2006 application performance is negatively effected when an 
Administrator logs on to the server. Soon after an administrator logs on to the 
machine, the CPS application performance becomes degrades to the point 
that the server must be restarted. 

Workaround: Create an administrator-equivalent account to perform system 
administration tasks. The administrator account should not be used; it should 
be renamed and password restricted as a security best practice. SPR#17355

Registration tab accelerator indicators do not display
Registration tabs do not display the following indicators for accelerators 
(underlined letters) so users can see which key strokes to use. All other 
indicators are appear in the application interface. SPR#18570, 13363

For this Registration tab... Use these key strokes...

Payment Plan Alt + P

Guarantor Alt + G

Additional Alt + I

Insurance Alt + U

Contacts Alt + S 

Note: Save is Ctrl + S

Appointments Alt + T

Financial Alt + C

Payment Plan Alt + L
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OCX registration errors may occur on some workstations 
immediately after installing the service pack 
A small number of workstations may experience a problem registering OCX 
controls following installation. Some users may see this error the first time 
they launch the application after the update: SPR 18346

Workaround: To prevent this error, do the following:

 Log onto the workstation with Administrator rights to launch the 
application for the first time

 Grant all users Administrator rights for the first day following installation. 

Faxing prescriptions in not supported in the state of Ohio
While it is possible to fax prescriptions in Ohio using the correct prescription 
form, the state pharmacy board requires two-factor authentication to ensure 
Rx authenticity. Two-factor authentication provided by biometrics integration 
is not currently supported in Centricity Practice Solution. SPR18369

SQL Instance name with a forward slash is truncated in Server Setup
If your SQL Instance name includes a machine name such as “VSH-
MIS06\SQL2005”, the Server Name value in Server Setup application displays 
only the machine name, and you will receive a connection error if it is not 
corrected manually.

Workaround: Manually add the end of the SQL instance name to Server Name 
fields where prompted to avoid the connection error message. SPR17894

Unsupported characters cause errors, warnings and claim rejections
The following characters are not supported by SQL Server and should not be 
used in the fields detailed below. They will generate application errors or 
warnings or result in claim rejection by payers. SPR#17947, 17989

. period * asterisk

, comma # pound sign

: colon \ back slash

; semicolon / forward slash

- hyphen & ampersand

! exclamation point
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 DO NOT use these characters in these fields: 

Advanced printing window displays incorrectly when printing reports
Some users may experience difficulties in reading the Advanced Print Options 
window when printing reports. The page format and number of copies fields 
may display incorrectly.

Workaround: Before opening the Advanced Print Options window, turn off 
skinning by pressing Ctrl + Alt + J. SPR# 31916

Access product updates, documentation, and services
To download service packs, KnowledgeBase updates, or factory observation 
terms, go to http://centricitypractice.gehealthcare.com. On the Web site, you 
will also find release publications, Support contact information, and links to 
training and the Centricity Practice users’ group.

Sign up for email announcements
To receive e-mail announcements of new service packs, product alerts, 
maintenance reminders, tips and tricks, subscribe to the Centricity Practice 
Services mailing list. All GE customers can receive this free Listserv. To sign up, 
send e-mail to centricitypmservices@ge.com. Include your name, your 
company name, address, and phone number in the body of the message.

In this module.... Do not use unsupported characters in these fields...

Administration / Edit Insurance Carriers ListName, Address1, Address2, City, Zip

Administration / Edit Company ListName, Address1, Address2, City 

Administration / Edit Facility Address1, Address2, City

Administration / Edit Facility ListName

Administration / Edit Referring Provider Prefix, First, Middle, Last, Suffix, ListName, Address1, 
Address2, City

Administration / Edit Resource ListName, First, Middle, Last, Suffix

Administration / Edit Responsible
Provider

First, Middle, Last, Suffix, ListName, Address1, 
Address2, City

Registration / Patient Tab Patient ID, Title, First, Middle, Last, Suffix, Address1, 
Address2, City, Zip 

Registration / Guarantor Tab Title, First, Middle, Last, Suffix, Address1, Address2, 
City, Zip 

Registration / Insurance Tab Insured ID, Group ID 

http://centricitypractice.gehealthcare.com
http://centricitypractice.gehealthcare.com
mailto:centricitypmservices@ge.com
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Appendix A: 
Hardware/software requirements 
for Centricity Practice Solution 

Hardware/software requirements for Centricity Practice Solution 
These are summary requirements for Centricity Practice Solution. The 
following detailed resources are available on your documentation CD and on 
the Centricity Practice Solution Services Web site at 
http://centricitypractice.gehealthcare.com: 

 To calculate disk space and RAM requirements for your environment, use 
Calculating Hardware Requirements for Centricity Practice Solution 
(spreadsheet application)

 For detailed specifications and an overview of product features and 
options that impact software and hardware planning, see System 
Requirements for Centricity Practice Solution

 For detailed requirements and recommendations for WTS/Citrix 
environments, see Planning and installing Centricity Practice Solution in 
WTS/Citrix Environments.

Your GE Representative or Reseller can assist you in selecting the best 
equipment configuration.

Database server 

Processor - recommended

 Up to 25 users - Single Intel Xeon DC (Dual Core), 2.8GHz or faster, 2MB L2 
cache, 800MHz FSB or equivalent

 26 to 125 users - Dual Xeon DC (Dual Core), 2.8 GHz or faster, 2MB L2 
cache, 800 MHz FSB or equivalent

 126-250 users - Quad Intel Xeon DC (Dual Core) 2.8 GHz or faster, 2MB L2 
cache, 800 MHz FSB or equivalent

 Intel Core 2 dual processors should run at 2Ghz or faster, Intel Quad core 
processors should run at 1.86 GHZ or faster.

RAM and disk space - recommended minimum

 Up to 25 users - 4GB

Mirrored SCSI hard disk (RAID 1). 

 26 to 125 users - 8GB

Hardware RAID disk arrays (RAID 1+ 0 - disk mirroring with striping). See 
Calculating Hardware Requirements for Centricity Practice Solution to 
determine number of disks.

http://centricitypractice.gehealthcare.com
http://centricitypractice.gehealthcare.com
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 126 to 250 users - 16GB

See recommendations for 26 - 125 users.

 Requirements vary considerably depending on the size and complexity of 
your implementation. To calculate actual disk space and RAM 
requirements for your environment, use Calculating Hardware 
Requirements for Centricity Practice Solution (spreadsheet application 
available on your documentation CD). 

Disk and database file layout

 Locate database log files on a mirrored disk set.

 Locate all other database files on a separate RAID 1+0 disk set. At least 2 
spindles per 5 users, minimum 4 disks. 

  For >125 users locate tempdb on its own RAID 1+0 disk set. 

 Allow one tempdb data file per processor. Set tempdb data files to 100 MB 
with 10% autogrowth in size.

 Wherever possible, locate these files on separate drives: 

 transaction log

 tempdb data files

 windows page file

 SQLServr.exe 

 It is better to have many smaller spindles than a few large ones.

Other hardware requirements

 Network interface card - 32-bit or higher 100Base-T (100Mbit) or higher. 
In large environments, high-speed full-Gbit switch with multi-Gbit back 
plane recommended.

 Display - Color SVGA, minimum 1024 x 768 - Small Fonts, High Color (16-
bit, 65536 colors) or better

 UPS - (uninterruptible power supply) minimum 15 minutes emergency full 
load backup power

 CD-ROM - 20x-speed or faster 

 Modem - 56K baud or faster fax/modem

 Tape drive - for backups or backup system from another server with 
access to the application server

 Printers - mid-range laser printer required for some reports. Some low-
end printers do not have a large enough printable area. Dot-matrix 
printers may be required for printing forms with carbons.
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Required software

 Operating system: Microsoft Windows Server 2003, Standard or 
Enterprise Edition, R2, (32-bit ONLY, SP1 or later required)

Note: If you are running on Microsoft Windows Small Business Server 
2003, you must upgrade to SQL Server 2005. 

!!! Microsoft Windows 2000 Server and Small Business Server 2000 are 
no longer supported. 

After working closely with Microsoft on product performance issues, 
GE has determined that SQL 2005 interoperability with Windows 2000 
Server does not facilitate memory management requirements needed 
for Centricity Practice Solution. Because the -g1024 switch is not 
interpreted on Windows 2000 Server, systems running on that 
operating system will experience CLR cycling (performance 
degradation and DB disconnects). 

With this service pack, the Server Setup application will warn you if it 
detects that your database is running on Windows 2000 Server. GE 
strongly recommends that you upgrade to Windows Server 2003 or 
higher prior to the next service pack to take advantage of memory 
management features that support Centricity Practice Solution on SQL 
Server 2005. SPR#18344

 Browser: Internet Explorer (IE) 6.0, SP1 (if client is installed on server)

 Web server additional requirements:

 Internet Information Services (IIS) v6.0

  Microsoft.NET Framework 1.1, SP1

 Production database engine:

 Microsoft SQL Server 2005 Standard Edition, SP1 or later

 Microsoft SQL Server 2005 Workgroup Edition, SP1 or later

 Microsoft SQL Server 2005 Enterprise Edition, SP1 or later

 Single-user demo database engine: Microsoft SQL Express 

This version only supports a single-user demo database installed on a 
laptop or PC. Not for use in production or for networked training.

!!! Not for use in production. Database support and maintenance 
features required in Centricity Practice Solution are not included.   
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Client workstation / MIK / Data Transfer Station 

Required hardware

 See “Windows® Vista support” on page 3 for Microsoft Vista Business 
Edition hardware requirements

Processor - Pentium III, 1 GHz or higher

RAM - 1GB

Hard disk - Client: 36 GB or more; DTS/MIK: 76 GB or larger hard disk 
(excluding LLOGIC directory)

Network interface card - 32-bit or higher 100Base-T (100Mbit) or higher

Display - Color SVGA, minimum 1024 x 768 - Small Fonts, High Color (16-bit, 
65536 colors) or better

Video card - only clients running Schedule module with schedule displaying 
more than 8 resources. Required video graphics card with 128 MB RAM.

Monitor - 15" - 17"

UPS - (uninterruptible power supply) minimum 5 minutes emergency full load 
backup power

CD-ROM - 20x-speed or faster

Image capture devices - GE supports any twain-compliant digital video 
device, digital camera, or scanner that plugs into a USB port

Modem - 56K baud or faster fax/modem (for filing electronic insurance claims 
from workstations)

Tape drive - for backups or backup system from another server with access to 
the application server

Printers - Laser printer required for most reports, dot-matrix printer required 
for forms using carbons.

Required software

 Workstation 

 Windows Vista Business Edition

 Windows 2000 Professional SP4 (32-bit ONLY)

 Windows XP Professional SP2 (32-bit ONLY)

 Windows XP Tablet PC Edition 2004 (SP2 or later) or Windows XP Tablet 
PC Edition 2005

 Data Transfer Station (clinical data exchange)

 Windows 2000 Professional SP4 (32-bit ONLY)

 Microsoft Windows XP Professional SP2 (32-bit ONLY)
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 Microsoft Windows 2000 Server SP4 or Windows Server 2003 (SP1 or 
later, 32-bit ONLY) 

 MIK Workstation (billing/insurance data exchange)

 Windows XP Professional (SP2 or later) (32-bit ONLY) or Windows 2003 
Server (32-bit ONLY)

Other client software

 Internet Explorer (IE) 6.0, SP1 (also required on servers where client is 
installed)

 Microsoft .NET Framework 1.1, SP1 (required for database 
communications and installed if not present on the workstation)

WTS/Citrix server 

Required hardware

 10-20 users (10 per processor) - Minimum - Dual Intel Xeon DC, 2.8 GHz or 
higher, 2 MB L2 cache, 800 MHz FSB. 

 Intel Core 2 dual processors should run at 2Ghz or faster, Intel Quad 
core processors should run at 1.86 GHZ or faster.

 RAM - Varies - see Planning and installing Centricity Practice Solution in 
WTS/Citrix Environment for recommended calculations and variables.

 Disk space - For Microsoft® Windows 2000 Server/ Server 2003 Terminal 
Services with Citrix Presentation Server 4.0:

 1.2 GB for the operating system

  + 600 MB for Centricity Practice Solution 

  + Page file size (2x application server RAM)

This assumes that Centricity Practice Solution and the page file reside 
on the same disk drive as the application server operating system.

Required software 

 Server operating system:

 Microsoft Windows 2000 Server, SP4 (with Terminal Services) (32-bit 
ONLY) with Citrix® Presentation® Server 4.0 (required)

!!! When Windows 2000 Terminal Server is used as a platform, RDP 
thin clients will not meet minimum display requirements and color 
ergonomics might be impacted. SPR #18343

 Microsoft Windows Server 2003, Enterprise Edition, SP1 (with Terminal 
Services) (32-bit ONLY) with or without Citrix Presentation Server 4.0
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 Other software

 Internet Explorer (IE) 6.0, SP1 

 Microsoft .NET Framework 1.1, SP1

 Microsoft Data Access Components (MDAC) 2.8 (on Windows 2000)

WTS/Citrix clients

 Citrix® ICA® Client (Win32): v9.100.36280 or higher configured for 
1024x768 High Color (16-bit, 65536 colors) or greater display resolution

 Microsoft® RDP client: v5.2 or higher (with Windows Server 2003 and 
higher) SPR #18343

 Thin client: any ICA / RDP compliant device

Unsupported operating systems
The following operating systems are NOT compatible with Centricity Practice 
Solution:

 Windows Vista Starter, Windows Vista Home Basic, Windows Vista Home 
Premium, Windows Vista Enterprise, Windows Vista Ultimate

 Windows NT Workstation, 9x, ME, or XP Home Edition

 Windows 2000 Server (except as noted for WTS/Citrix server on page 46)

 Windows Server 2003 Web Edition or Windows NT 4.0 Server

 Small Business Server 2000

 Any 64-bit editions of Microsoft Windows operating systems

 Microsoft SQL Server 2005 Development Edition

 Microsoft SQL Express. This version only supports Centricity Practice 
Solution single-user evaluation demo database.
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